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Chapter 1.   Getting Started

The License Installation Guide provides information and procedures to:

� Obtain a license

� Install permanent concurrent-user licenses

� Perform license maintenance

� Install permanent single-user licenses

� Troubleshoot license installation errors.

In addition, this guide gives an overview of the tasks required to install a license; explains 

the new trial or demo license feature and the different types of licenses available; helps 

you decide which type of license to request; and gives definitions to many of the terms 

used in this guide.

Terminology

CompuLock license See evaluation license.

Concurrent-user license This type of licensing allows you to run the 

product on more than one workstation so that 

multiple users can access it and is installed on 

a machine that acts as a server to any number 

of machines that are configured to access it.

Daemon The vendor daemon is used to count (or check 

licenses in and out) for concurrent-user 

licenses. If your license contains server and 

daemon lines without a # sign in front of them, 

it is a concurrent-user license that is to be 

installed on a machine dedicated as the server. 

Literally, daemon is an acronym ‘Disk And 

Execution MONitor’. It is a program that is 

not invoked explicitly, but lies dormant 

waiting for some condition(s) to occur. The 

idea is that the perpetrator of the condition 
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need not be aware that a daemon is lurking 

(though often a program will commit an action 

only because it knows that it will implicitly 

invoke a daemon).

Default time-limited trial license See evaluation license.

Evaluation license This type of licensing is installed when you 

install your Compuware product and it allows 

you to run the product for a specific time 

period (typically 30 days from the day you 

install the product).

Extended trial license See temporary license.

FLEXlm license server This is one of the most popular license 

managers used in the software industry today. 

It is best known for its ability to allow 

software licenses to be available (or float) 

anywhere on a network, instead of being tied 

to specific machines. This GLOBEtrotter 

Software product keeps track of how many 

licenses are checked out and by whom. 

Floating license See concurrent-user license.

Host name A unique name that identifies a computer on a 

network. A single computer can have several 

host names, also called aliases.

Host ID The machine identification number of a host. 

For Windows PCs, this would be the Ethernet 

address of the network interface card.

LAU See License Administration Utility.

License Administration Utility This is an application designed to help you set 

up and manage your license files and set your 

environment. By using this utility, you do not 

have to manually type in information or open 

the license file in a text editor and risk 

corrupting your file or typing the information 

incorrectly. You can view details of a product 

license and get hints to solve many of your 

licensing errors.

License Manager Compuware’s License Manager contains the 

FLEXlm license server component and the 

License Administration Utility. Both of these 

components enable the License Manager to 
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check licenses in and out and maintain the 

master license file.

License Manager server The dedicated machine upon which you will 

install the Compuware License Manager. 

LM See License Manager.

Master license file This is the repository for the licensing 

information for all the products you have 

installed on your machine. When you get a 

new product license, you will append that 

information to the master license file using the 

License Administration Utility.

Network license See concurrent-user license.

Node-locked license See single-user license.

Permanent license This type of license gives you access to the 

product under the terms of your contract with 

Compuware. Compuware offers two types of 

permanent licenses: single-user and 

concurrent-user.

Product license file This is the license file that you received via e-

mail from Compuware License Management. 

You should save this file to a temporary 

directory on your computer and make a note of 

it for future reference.

Rolling trial license See evaluation license.

Server On a local area network, a computer running 

administrative software that controls access to 

the network and its resources, in this case the 

product licenses, and provides resources to 

computers functioning as workstations (client 

machines) on the network.

Single-user license This type of license allows the product to run 

on a single, specified workstation (node). The 

product cannot be used on any other 

workstation.

Temporary license This type of license gives you an opportunity 

to extend your trial use of the product once the 

evaluation license expires (typically 30 days 

from the day you install the product). It gives 

an unlimited number of users access to the 

product for a limited time period.
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Task Overview

The following are brief guidelines for installing a license with cross references to 

locations containing more detail:

1. Determine what type of license you need. 

See “Choosing Your License” on page 1-6.

2. Determine the host name and host ID of the machine on which you will be installing 

your license. See “Determine the Host Name and Host ID” on page 1-7.

3. Send the host IDs and host names to Compuware License Management and get a 

license file in return. See “Obtain the License” on page 1-8.

4. Determine if you need to install or update the License Manager. 

• If you are installing a temporary (extended trial) license or a permanent single-

user (node-locked) license, you do not need to install the License Manager. See 

“Installing a Single-User License on Windows” on page 2-12 or “Installing a 

Single-User License on UNIX” on page 3-4 for license installation instructions.

• If you are installing a permanent concurrent-user (floating or network) license, 

you need to install the License Manager. If you already have the license but 

don’t know what type it is, you can open the license sent to you in Notepad or 

DOS EDIT (or in vi if UNIX) and search for the terms “server” and “daemon.” 

(Do not open the license in any other text editor. If you do, you may corrupt the 

file even if you don’t save it!) If your license has lines that contain those key-

words without a # in front of them, you need to install a License Manager. See 

“Installing the License Manager and a Concurrent-User License” on page 2-2 

for a Windows platform, “Installing the License Manager” on page 3-1 for a 

UNIX platform, or “Installing the License Manager” on page 4-1 for a Novell 

platform. 

• If the License Manager is already installed, you may need to update it. To com-

pare the version you have on your server machine with the version on the prod-

uct CD, see “Before You Begin” on page 2-2 for instructions.

5. Enter the license information.

• For Windows platforms, see “Installing the License Manager and a Concurrent-

User License” on page 2-2, “Concurrent-User License Maintenance” on page 

2-9, or “Installing a Single-User License on Windows” on page 2-12.

• For UNIX platforms, see “Installing a Concurrent-User License” on page 3-2 

or “Installing a Single-User License on UNIX” on page 3-4.

• For Novell platforms, see “Installing a License” on page 4-2.

6. If this is a permanent concurrent-user license, configure each client machine to 

access the License Manager on the server machine. 
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• For Windows platforms, see “Configuring Each Client Machine” on page 2-11 

• For UNIX platforms, see “Configuring Each Client Machine” on page 3-3 

• For Novell platforms, see “Configuring Each Client Machine” on page 4-3.

7. If this is a permanent concurrent-user license, set up the License Manager to start 

automatically at boot time. 

• For Windows platforms, see “Running the FLEXlm License Server as a Ser-

vice” on page 2-6 or “Running the FLEXlm License Server in Console Mode” 

on page 2-7.

• For UNIX platforms, see “Configuring the License Manager for Automatic 

Startup” on page 3-3.

• For Novell platforms, see “Configuring the License Manager for Automatic 

Startup” on page 4-7.

Evaluation License

Your QACenter product has a built-in trial license that allows you to evaluate the product 

for a specific time period, typically 30 days from the day of installation. When you start 

up the product during the trial period, a dialog box informs you how much evaluation time 

remains. 

� If you want to continue evaluating the product without obtaining a license, click 

OK.

� If you have a permanent license that you would like to configure, click License. 

Follow the instructions that pertain to your needs:

• Chapter 2, “Installing a License on Windows”
• Chapter 3, “Installing a License on UNIX”
• Chapter 4, “Installing a License on Novell”. 

When the evaluation time period expires, an error dialog box appears:
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You must then either install a permanent license in order to run the product or contact your 

Compuware sales representative to extend your trial period by obtaining a temporary 

license. If you get a temporary license, you will install it using the same procedures as for 

a permanent single-user license. See “Choosing Your License” on page 1-6 to help you 

decide which type of license to obtain. 

Choosing Your License

Once your evaluation license expires, you must install a license. If you want to extend 

your evaluation period by obtaining a temporary license, contact your Compuware sales 

representative. Otherwise you must choose the type of permanent license you want.

A permanent license gives you access to the product under the terms of your contract with 

Compuware. Compuware offers two types of permanent licenses: single-user (node-

locked) and concurrent-user (floating or network). The type of license you choose 

depends upon the specific needs of your site.

� Single-User — If you only need one copy of the product on one workstation, a per-

manent single-user license should meet your needs. This type of license allows the 

product to run on a single, specified workstation (node). The product cannot be used 

on any other workstation. This license type is also referred to as a node-locked 

license.

� Concurrent-User — If you need to run the product on more than one workstation so 

multiple users can access it, a permanent concurrent-user license should best meet 

your needs. This type of license is installed on a machine that acts as a server to any 

number of workstations that have access to it. It allows a predetermined number of 

users on different workstations to use the product at the same time. You can install 

the product on any number of workstations. Your license determines how many 

users may access the product at a time. This license type is also referred to as a 

floating or network license.

If you choose a concurrent-user license, you must install License Manager on a machine 

that acts as the license server. License Manager is not required to use single-user licenses.
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Requesting a Permanent License

You need to provide Compuware License Management with your machine’s identifying 

information.

� To obtain a single-user license, you must provide Compuware with the host ID of 

the machine on which you will run the product. 

� To obtain a concurrent-user license, you must provide Compuware with the host 

name and host ID of the machine designated as the License Manager server. 

Compuware provides you with a permanent license that is customized for your needs. 

Keep in mind that each product license is individually created to work on a specific 

machine. The license cannot be transferred to another machine.

Determine the Host Name and Host ID

Use the License Administration Utility (LAU) to obtain the host name and host ID that 

Compuware License Management needs to create the license.

1. Use one of the two methods described below to start the utility.

Starting the Utility After License Manager Has Been Installed

a. Click the taskbar’s Start button and choose Programs>Compuware>License 

Manager>License Administration Utility.

b. Continue with step 2.

Starting the Utility When License Manager Is Not Installed

a. Insert the CD. The CD browser should automatically appear. If it does not, nav-

igate to the root directory and run the setup.exe file.

b. Click Install QACenter Products.

c. Click Run License Administration Utility.

d. Continue with step 2.

2. When the License Administration Utility dialog box appears, the Host Information 

field displays the host name and host ID for your machine.

Caution

You must perform this task on the machine where you intend to install the product license, 

and you must use the License Administration Utility as described. If you use any other 

method, the information you obtain may be incorrect.
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3. From the File menu, choose Save. The Save As dialog box appears.

4. The default filename, hostinfo.txt, appears in the File name field. From the 

Save in list, select the directory where you want to save the file, then click Save.

5. Exit the License Administration Utility.

Obtain the License

To obtain the permanent license, e-mail the file hostinfo.txt to Compuware License 

Management at license_mgt@compuware.com. You can also contact your sales represen-

tative. Compuware License Management will send you the permanent license infor-

mation by e-mail (as a file attachment). 

When you receive your license key by e-mail, save the file you receive to a temporary 

directory. Make a note of this directory so that you can refer to it later when prompted for 

the product license location. If you want to view your license, open it in Notepad or DOS 

EDIT (or if UNIX, in vi). If you open it in any other text editor, you may corrupt it even 

if you don’t save it.

Where To Go Next

Depending upon the platform where you will be installing the license, proceed to the 

appropriate chapter:

� Chapter 2, “Installing a License on Windows”

� Chapter 3, “Installing a License on UNIX”

� Chapter 4, “Installing a License on Novell”.
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Chapter 2.   Installing a License on Windows

The licensing process varies based on the Compuware product being installed, your 

agreement with Compuware, and the platform. This chapter includes the following 

sections:

� Installing the License Manager and a Concurrent-User License — Instructions 

for installing the License Manager on the machine that acts as the FLEXlm license 

server for concurrent-user licenses. A concurrent-user license should be installed at 

the same time.

� Running the FLEXlm License Server as a Service — Instructions for installing 

FLEXlm as a service on Windows NT or Windows 2000. This will be necessary 

only if you did not install a license when you installed the License Manager.

� Running the FLEXlm License Server in Console Mode — Instructions for 

installing FLEXlm as a console application on Windows 95, 98, NT, or 2000. This 

will be necessary only if you did not install a license when you installed the License 

Manager.

� Concurrent-User License Maintenance — Instructions for adding a new product 

license to your existing master license file.

� Configuring Each Client Machine — Instructions for configuring each client 

machine that will check out a license from the server machine.

� Installing a Single-User License on Windows — Instructions for installing a sin-

gle-user license on a Windows workstation.

� Troubleshooting — A few of the more common problems encountered during the 

license installation and their possible solutions.
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Installing the License Manager and a Concurrent-User 
License

It is necessary to install the License Manager only if your license has “server” and 

“daemon” lines (to determine whether it does, open the license in Notepad or DOS EDIT 

for Windows or vi for UNIX and search for the terms “server” and “daemon” without a # 

in front of them). This license type is known as concurrent-user licensing. 

Concurrent-user licensing allows you to purchase a specific number of licenses without 

assigning these licenses to particular workstations. Instead, licenses are “checked out” by 

users on a first-come, first-served basis when they access the product. When all available 

licenses are issued, no additional users can run the product until another user exits and a 

license is “checked in.” This request-and-issue process is managed by the License 

Manager, specifically by the FLEXlm License Server portion of the License Manager. 

The License Manager must be running on a computer or server that is always available to 

all client workstations needing access to the product. 

Check the prerequisites in “Before You Begin” before proceeding to “Installation 

Process” for instructions.

Before You Begin

There are a few things you should check before you begin installing the License Manager 

and a new concurrent-user license:

� Make sure you know the location of your product license file. You received the 

product license file as an e-mail attachment from Compuware License Manage-

ment. If you haven’t done so already, save the attached product license file to a tem-

porary directory on your computer. You will need to select the product license file 

later in this procedure.

� Check to see if License Manager is already running on your machine. 

• If it is not already running on your machine, continue with this procedure. 

• If it is already running on your machine, you may need to update it. To compare 

the version you have on your server machine with the version on the product 

CD:

— Navigate to the directory where License Manager is located on the server 

machine.
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— Type lmutil lmver lmgrd.exe and press Enter. Find the version number in 

the resulting message. 

lmutil - Copyright (C) 1989-1997 Globetrotter Software, Inc.

FLEXlm Copyright 1988-1996, Globetrotter Software, Inc.

FLEXlm 5.12a (libmgr_s.a), Copyright (C) 1988, 1997 Globetrot-
ter Software Inc.

— Insert the product CD into the CD-ROM drive and open a prompt.

— Type lmutil lmver lmgrd.exe and press Enter.

If the CD has a newer version of the License Manager,  update your License 

Manager by uninstalling the previous version, rebooting if necessary, and 

installing from the CD using this procedure.

• If you have the current version of the License Manager and have already set up 

a master license file directory , do not use this procedure. Go to “Concurrent-

User License Maintenance” on page 2-9 for instructions instead.  

� Check to see if there is a pre-existing master license file. Check in your system 

directory for a \Program Files\Compuware\License\license.dat file. If 

you already have this master license file and have already installed the License 

Manager, do not use this procedure. Instead, see “Concurrent-User License Mainte-

nance” on page 2-9 for instructions on adding a new product license to an existing 

master license file.

� Check for a file on your system directory called \flexlm\license.dat.  If this 

file exists, change the filename to old_license.dat. If you do not change the 

filename, FLEXlm may mistakenly use this license file rather than the correct prod-

uct license file.

Installation Process

Choose a stable Windows (95, 98, NT, or 2000) machine that is dedicated as the License 

Manager server. To install the License Manager, follow these steps:

1. Insert the CD into the CD-ROM drive. The CD browser should automatically dis-

play. If it does not, navigate to the root directory and run the setup.exe file.

2. Click Install QACenter Products. 

3. Click Install License Manager. 

The Welcome dialog box appears.

Caution

Compuware recommends that you exit all Windows programs before running this setup 

program. Some Windows programs, such as anti-virus software, may interfere with the 

installation process. 
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4. Read the welcome screen and click Next. The License Agreement dialog box 

appears.

5. Read the license agreement and click Yes to accept the terms of the agreement. The 

Customer Information dialog box appears.

6. Type your name and company in the User Name and Company Name fields. Click 

Next. The Choose Destination Location dialog box appears.

7. Select a location for the License Manager installation.

• By default, the License Manager installs in the folder
x:\Program Files\Compuware\License Manager

where x is the drive where Windows resides on your computer.

• To specify a different path, click Browse and select an existing folder or type 

the path in the Path field.

8. Click Next. The Select Program Folder dialog box appears.

9. Specify a location for the License Manager program shortcuts. You may type a new 

folder name, or select one from the existing folders list. Click Next. The Start 

Copying Files dialog box appears.

10. Review the summary of settings and click Next to start copying the program files. 

The Setup Status dialog box displays the progress of the installation. 

11. After all of the files are copied, a dialog box appears asking if you want to install a 

license. Click Yes, the LAU - File Location dialog box appears:

Caution

If you are installing the License Manager on Windows NT or 2000, you must install a valid 

license at this time. If you do not, you may have problems running the product that will 

force you to uninstall and reinstall the License Manager in DOS later. At the very least, the 

FLEXlm License Server service will not be installed and shortcuts to start and stop the 

FLEXlm License Server will not be created. The FLEXlm License Server is an integral 

part of the License Manager and is responsible for the “checking in and out” of the 

licenses. If you choose to install your license later, you must then set up the service or the 

shortcuts. See “Running the FLEXlm License Server as a Service” on page 2-6 or 

“Running the FLEXlm License Server in Console Mode” on page 2-7 for instructions.
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12. Type, or browse for, the location of the product license file. This is the file that you 

received by e-mail from Compuware License Management as a file attachment and 

saved to a temporary directory. 

13. Click OK. The LAU - Master File Location dialog box appears:

14. Create the directory where you will place your master license file by typing 

x:\Program Files\Compuware\License\license.dat, where x is the 

directory where your operating system is installed. This file that will contain all of 

the information about the License Manager server and the product licenses that 

reside there.

15. Click OK. The new product information will be copied to this new master license 

file.

16. Click OK. The environment is set to the master license file location. If you are 

notified that the environment has not been set, simply click Yes to set the license 

environment.

17. After the license is installed, the Setup Complete dialog box appears. Depending on 

the circumstances, you may receive one of the following prompts:

• You may be prompted to view the Readme file and register for FrontLine tech-

nical support. FrontLine provides fast access to critical information such as 

documentation, frequently asked questions, and product fixes. The first time 

you access FrontLine, you are required to register and obtain a password.

Choose whether to review the information in the License Manager Readme file. 

This file contains information about new features, notes and issues that may 

enhance or impact the License Manager’s performance, and information on 

how to contact Compuware.

• You may be prompted to restart your computer. If you are prompted to restart 

your computer, you may choose to restart it now (recommended) or to restart it 

later.

18. Click Finish to complete the installation of the License Manager.
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Running the FLEXlm License Server as a Service

If you did not install a license during installation of the License Manager on Windows NT 

or Windows 2000, the FLEXlm License Server service was not installed. The FLEXlm 

License Server is an integral part of the License Manager and is responsible for the 

“checking in and out” of the licenses. This service is what automatically starts and stops 

the License Manager whenever you boot up your computer.

This procedure applies to concurrent-user licenses only on Windows NT or 2000. If you 

are running on Windows NT or 2000, you may choose to run FLEXlm as a service or as 

a console application. If you do not have full administrator rights to Windows NT or 2000 

or if you need to occasionally run diagnostics, see “Running the FLEXlm License Server 

in Console Mode” on page 2-7 for instructions on running FLEXlm as a console appli-

cation.

Follow these steps to install the FLEXlm License Server service:

1. Open a Command Prompt window and navigate to the directory where the License 

Manager is installed.

2. Run installs -R. This removes the License Manager if it has been incorrectly 

installed. Note the output.

3. Run installs.exe -e <PATH> -c <PATH> -l <PATH>. Details of the parameters are 

as follows:

-e <PATH>  The fully qualified path to lmgrd.exe

-c <PATH> The fully qualified path to the license file.

-l <PATH> The fully qualified path to the log file.

If the paths are long filenames, they must be converted to their equivalent short file-

names.

Example:

 installs.exe
-e C:\progra~1\compuw~1\License\lmgrd.exe

-c C:\progra~1\compuw~1\License\license.dat

-l C:\progra~1\compuw~1\License\lmgrd.log

Caution

Do not attempt to run as both a service and a console application.

If the FLEXlm License Server is started as a service on Windows NT or 2000, it is 

possible for the license server to be shut down by any user. If this is a concern, it is 

advisable to start the license server in console-only mode with the option “-2 -p”. (See 

“Running the FLEXlm License Server in Console Mode” on page 2-7 for instructions.) If 

this option is employed, then the license server can only be shut down from the Task 

Manager.
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4. Continue with the process below that applies to the operating system you are using 

on your server.

Windows NT 1. Exit the CD if necessary.

2. Click on the taskbar’s Start button and choose Settings>Control Panel. 

3. Click the Services icon. A list of services appears.

4. Choose the FLEXlm service from the list. The Service dialog box appears.

5. The startup type default is “Automatic.” This is the desired startup type.

6. Click OK to start up the FLEXlm service.

Windows 2000 1. Exit the CD if necessary.

2. Click on the taskbar’s Start button and choose Settings>Control Panel. 

3. Click the Administrative Tools icon. Click the Services icon. A list of services 

appears.

4. Choose the FLEXlm service from the list. The FLEXlm Properties dialog box 

appears.

5. The startup type default is “Automatic.” This is the desired startup type.

6. Click Start to start up the FLEXlm service.

Running the FLEXlm License Server in Console Mode

If you did not install a license during installation of the License Manager, the FLEXlm 

License Server application shortcuts were not installed in your computer’s Startup folder. 

The FLEXlm License Server is an integral part of the License Manager and is responsible 

for the “checking in and out” of the licenses. This application is what automatically starts 

and stops the License Manager whenever you boot up your computer.

This process applies to concurrent-user licenses for Windows 95, 98, NT, and 2000. You 

can create shortcuts to start and stop the License Manager as a console application for 

Windows 95, 98, NT, or 2000. If you do not have full administrator privileges to Windows 

NT or 2000 or if you want to occasionally run diagnostics on a Windows NT or 2000 

machine, you should run FLEXlm as a console application.

Follow these steps to create shortcuts for starting and stopping the FLEXlm license server 

and to place them in your computer’s Startup folder:

Caution

Do not attempt to run as both a console application and a service.
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1. Using Windows Explorer, navigate to the directory where the shortcuts for the 

License Manager were installed.

2. Create a shortcut named “Start FLEXlm License Server”.

The Target location for the shortcut should be:

<Path of lmgrd.exe> -app -c <Path of license file>

• <Path of lmgrd.exe> is the fully qualified path to lmgrd.exe. If this path is a 

long filename, it should be enclosed by quotation marks.

• <Path of license file> is the fully qualified path to the license file. If this path is 

a long filename, it must be converted to its equivalent short filename.

Example: 
“C:\Program Files\Compuware\License\lmgrd.exe” -app 

-c C:\progra~1\compuw~1\license\license.dat 

The Start in location for the shortcut should be the directory containing 

lmgrd.exe. If this path is a long filename, it should be enclosed by quotation 

marks.

Example:

 “C:\Program Files\Compuware\License”.

3. Create a shortcut named “Stop FLEXlm License Server”.

The Target location for the shortcut should be:

<Path of lmutil.exe> lmdown -c <Path of license file>

• <Path of lmutil.exe> is the fully qualified path to lmutil.exe. If this path is a 

long filename, it should be enclosed by quotation marks.

• <Path of license file> is the fully qualified path to the license file. If this path is 

a long filename, it must be converted to its equivalent short filename. 

Example: 
“C:\Program Files\Compuware\License\lmutil.exe” lmdown 

-c C:\progra~1\compuw~1\license\license.dat 

The Start in location for the shortcut should be the directory containing lmutil.exe. If 

this path is a long filename, it should be enclosed by quotation marks. Example: 

“C:\Program Files\Compuware\License”.

Note

If you want the FLEXlm License Server to be started automatically when you start the 

computer, make a copy of this shortcut and place it in the “Startup” folder.
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Concurrent-User License Maintenance

Use this procedure only to add a concurrent-user license for a new product when you 

already have the License Manager installed and the master license file set up. If you have 

not yet installed the License Manager, see “Installing the License Manager and a 

Concurrent-User License” on page 2-2 for instructions. This procedure merges a new 

concurrent-user product license with your master license file on Windows.

1. Before you begin, make sure you know the location of your product license file. 

You received the product license file as an e-mail attachment from Compuware 

License Management. If you haven’t done so already, save the attached product 

license file to a temporary directory on your computer. You will need to select the 

product license file later in this procedure.

2. Start the License Administration Utility (LAU). You can start the LAU while 

logging into the product, or you can start the LAU from the program group in the 

Windows Start menu. 

• During logon: When you start a product that has an evaluation license, you are 

informed of how much evaluation time remains. When you are ready to install 

a permanent concurrent-user license, click License.

The License Administration Utility (LAU) appears.

• From Windows Start menu: Click the taskbar’s Start button and choose Pro-

grams>Compuware>License Manager>License Administration Utility.

The License Administration Utility (LAU) appears:
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3. Type, or choose from the drop-down list, the master license file location in the 

License File or Server field.

4. Click Add. The LAU - File Location dialog box appears:

5. Type, or browse for, the location of the product license file. This is the file that you 

received by e-mail from Compuware License Management as an attachment and 

saved to a temporary directory. 

6. Click OK. The LAU - Master File Location dialog box appears:

7. This dialog box displays the master license file you selected in step 3. Verify that it 

is correct and click OK. The new product information will be merged with the 

current master license information.

8. Click OK. The environment is set to the master license file location. If you are 

notified that the environment has not been set, simply click Yes to set the license 

environment.

9. Check the updated master license file, license.dat, to ensure that the 

FEATURE line for the products you just added are in the file as well as all the 

FEATURE lines of the products that you had previously. Make certain that the valid 

licenses’ FEATURE lines do not have a # in front of them. If you have any 

questions, call Compuware Technical Support at 1-800-538-7822. 

After you merge a new product license to the master license file, the previous ver-

sion of the master license file will be archived and named License.nnn where nnn 

is a number beginning at 001 and is incremented up to 010. These are your license 

backups or archives. 
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Configuring Each Client Machine

This procedure applies to concurrent-user licenses only. Each client workstation must be 

configured to access the License Manager. 

1. Start the License Administration Utility (LAU). You can start the LAU while log-

ging into the product, or you can start the LAU from the QACenter CD. 

• During logon: When you start a product that has an evaluation license, you are 

informed of how much evaluation time remains. When you are ready to install 

a permanent concurrent-user license, click License.

The License Administration Utility (LAU) appears.

• From the QACenter CD: Insert the QACenter CD into the CD-ROM drive. 

The CD browser should automatically display. If it does not, navigate to the 

root directory and run the setup.exe file. Click Install QACenter Products. 

Click Run License Administration Utility. The License Administration Util-

ity appears.

2. From the Tools menu on the License Administration Utility main window, choose 

Set Environment. The Set Environment dialog box appears:

3. Click Browse and navigate to the License Manager server location on the Open file 

dialog box. 

4. Click Open.

5. Click OK to add the file to the current environment setting. Reboot the machine for 

these changes to take effect.
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Installing a Single-User License on Windows

Use this procedure to install a single-user (node-locked) license; this license may be an 

extended temporary license or a permanent license. You may have received your 

permanent license when you purchased your product; or you may have requested it after 

having evaluated the product. In either case, after you receive the permanent license, you 

need to enter the license information into your master license file.

1. Before you begin, make sure you know the location of your product license file. 

You received the product license file as an e-mail attachment from Compuware 

License Management. If you haven’t done so already, save the attached product 

license file to a temporary directory on your computer. You will need to select the 

product license file later in this procedure.

2. Start the License Administration Utility (LAU). You can start the LAU while 

logging into the product, or you can start the LAU from the QACenter CD. 

• During logon: When you start a product that has an evaluation license, you are 

informed of how much evaluation time remains. When you are ready to install 

a permanent concurrent-user license, click License.

The License Administration Utility (LAU) appears.

• From the QACenter CD: Insert the QACenter CD into the CD-ROM drive. 

The CD browser should automatically display. If it does not, navigate to the 

root directory and run the setup.exe file. Click Install QACenter Products. 

Click Run License Administration Utility. The License Administration Util-

ity appears:
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3. Type, or browse for, the master license file location in the License File or Server 

field. If you do not already have a master license file defined, type 
x:\Program Files\Compuware\License\license.dat

where x is the drive where your operating system resides.

4. Click Add. The LAU - File Location dialog box appears:

5. Type, or browse for, the location of the product license file. This is the file that you 

received by e-mail from Compuware License Management as an attachment and 

saved to a temporary directory. 

6. Click OK. The LAU - Master File Location dialog box appears:

7. This dialog box displays the master license file you selected in step 3. Verify that it 

is correct and click OK. The new product information will be merged with the 

current master license information.

8. Click OK. The environment is set to the master license file location. If you are 

notified that the environment has not been set, click Yes to set the license 

environment.

9. Check the new or updated master license file, license.dat, to ensure that the 

FEATURE line for the products you just added are in the file (as well as all the 
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FEATURE lines of the products that you had previously, if this is an update). Make 

certain that the valid licenses’ FEATURE lines do not have a # in front of them. If 

you have any questions, call Compuware Technical Support at 1-800-538-7822.

After you merge a new product license with an existing master license file, the pre-

vious version of the master license file will be archived and named License.nnn 

where nnn is a number beginning at 001 and is incremented up to 010. These are 

your license backups or archives.

Troubleshooting

This section offers some suggestions for troubleshooting license installation errors. The 

License Administration Utility online help provides extensive troubleshooting infor-

mation as well. 

The FLEXlm License Server is Not Listed in the Services List

This applies to Windows NT or 2000 only because Windows 95 and 98 do not have 

services lists.

� If you elected not to install a license when installing the License Manager, the 
FLEXlm License Server service was not installed either. For instructions on install-
ing the service, see “Running the FLEXlm License Server as a Service” on page 2-
6. 

� If you decided to run the FLEXlm License Server as a console application, it will 
not be listed in the services list because you should not run the FLEXlm License 
Server as both a service and as a console application.

FLEXlm Cannot Be Started as a Service

The FLEXlm License Server was not installed either as a service or had shortcuts created 

to run in console mode. See “Running the FLEXlm License Server as a Service” on page 

2-6 for instructions on installing the FLEXlm License Server to run as a service on 

Windows NT or 2000. See “Running the FLEXlm License Server in Console Mode” on 

page 2-7 for instructions on creating shortcuts to start and stop the FLEXlm License 

Server in console mode.

The FLEXlm License Server Does Not Start

� If you did not reboot your machine after installation, reboot now.

� Try starting the FLEXlm server by clicking the taskbar’s Start button and choosing 
Programs/Compuware/License Manager. If the server still does not start, you 
might receive a descriptive message that will assist you in troubleshooting the prob-
lem.
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� The license file you specified as the master license file has been moved or is not 
located in the specified directory. You may not be able to see a file if your folder set-
tings are preventing you from doing so. To verify that your settings are correct, open 
Windows Explorer and choose Folder Options from the View menu. Click the 
View tab on the Folder Options dialog box. The Advanced Settings options should 
have the Show all files option selected and the Hide file extensions for known file 
types option cleared. 

If that doesn’t resolve your problem, refer to the troubleshooting information in the 
License Administration Utility online help or contact Compuware Technical Sup-
port for assistance.

� The license file may contain invalid data. Refer to the troubleshooting information 
in the License Administration Utility online help or contact Compuware Technical 
Support for assistance.

FLEXlm License Server Does Not Recognize a New License

If you run the FLEXlm License Server as a service, you must refresh the License Server 

after adding a new license file. To do this, click the taskbar’s Start button and choose 

Programs>Compuware>License Manager>License Administration Utility. The 

License Administration Utility main window appears. Choose Refresh License Server 

from the Tools menu.

The Product That Was Just Licensed Won’t Run

The FLEXlm License Server was not installed either as a service or had shortcuts created 

to run in console mode. See “Running the FLEXlm License Server as a Service” on page 

2-6 for instructions on installing the FLEXlm License Server to run as a service on 

Windows NT or 2000. See “Running the FLEXlm License Server in Console Mode” on 

page 2-7 for instructions on creating shortcuts to start and stop the FLEXlm License 

Server in console mode.
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Chapter 3.   Installing a License on UNIX

The licensing process varies based on the Compuware product being installed, your 

agreement with Compuware, and the platform. This chapter includes the following 

sections:

� Installing the License Manager — Instructions for installing the License Manager 

on the machine that acts as the FLEXlm server machine for concurrent-user 

licenses.

� Installing a Concurrent-User License — Instructions for installing a concurrent-

user license on the server machine.

� Configuring Each Client Machine — Instructions for configuring each client 

workstation that will check out a license from the server machine.

� Installing a Concurrent-User License — Instructions for enabling the License 

Manager to start up automatically whenever the server is rebooted.

� Configuring the License Manager for Automatic Startup — Instructions for 

shutting down the License Manager server machine.

� Installing a Single-User License on UNIX — Instructions for installing a single-

user license on a UNIX workstation.

Installing the License Manager

It is necessary to install the License Manager only if your license has “server” and 

“daemon” lines (to determine whether it does, open the license in a text editor and search 

for the terms “server” and “daemon”). This license type is known as concurrent-user 

licensing.

Concurrent-user licensing allows you to purchase a specific number of licenses without 

assigning these licenses to particular workstations. Instead, licenses are “checked out” by 

users on a first-come, first-served basis when they access the product. When all available 

licenses are issued, no additional users can run the product until another user exits and a 

license is “checked in.” This request-and-issue process is managed by the License 
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Manager, specifically by the FLEXlm License Server service portion of the License 

Manager. The License Manager must be running on a computer or server that is always 

available to all client workstations needing access to the product. 

Choose a stable UNIX machine that is dedicated as the License Manager Server. To install 

the License Manager, copy the contents of the platform-specific /cpwr/cwlm subdi-

rectory to a directory named /cpwr/license on your License Manager server.

Installing a Concurrent-User License

You must have the License Manager installed before you proceed. If you have not yet 

installed the License Manager, see “Installing the License Manager” on page 3-1 for 

instructions. The license.dat file must be installed on the License Manager server. 

Follow this procedure to install a permanent concurrent-user license on UNIX.

As an alternative to the steps below, you can use a Windows machine and the License 

Administration Utility’s Add function, then FTP the file to the UNIX machine.

1. Locate (on the License Manager server) the existing license.dat file, or use a 

text editor to create a file name license.dat and save it in the directory where the 

License Manager is located.

2. Paste or type your license string into the license file (don’t include information 

preceded with #). For example:

3. Save the license.dat file.

4. To start the License Manager, from the directory where the License Manager is 

located, type:

lmgrd -c /cpwr/license/license.dat

5. To verify installation of the License Manager, type

lmutil lmstat -a -c /cpwr/license/license.dat

A list of product features from the FEATURE lines appears.

6. Continue with “Configuring Each Client Machine” on page 3-3.

SERVER ServerName 0020af9adb94 TCP:7166

DAEMON compuware ./compuwar

FEATURE xplus Compuware 4.600 12-jan-1999 10 6C74309CB84A9F07C5ED\

VENDOR_STRING=989898;0;PERM ck=12

Caution

The license string is case-sensitive. 
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Configuring Each Client Machine

Each client workstation must be configured to access the License Manager. 

Set the LM_LICENSE_FILE environment variable in the global environment using the 

appropriate command for your particular shell.

C shell Use the following:

setenv LM_LICENSE_FILE 7166@hostname

Bourne shell Use the following:

LM_LICENSE_FILE=7166@hostname

export LM_LICENSE_FILE

Korn shell Use the following:

export LM_LICENSE_FILE=7166@hostname

Configuring the License Manager for Automatic Startup

Because all license validation is done by the License Manager, it must be started and kept 

running in order to use Compuware products. Log on as root and complete the appropriate 

procedure to automatically start the License Manager each time the License Manager 

server is started.

Sun Solaris In /etc/rc2.d, create a file named s95cwlm.server and add the following command 

to the file:

nohup lmgrd -c /cpwr/license/license.dat>>license.log&

SunOS Add the following command to /etc/re.local: 

nohup lmgrd -c /cpwr/license/license.dat>>license.log&

HP-UX In /sbin/rc3.d, create a file named s95cwlm.server and add the following 

command to the file:

nohup lmgrd -c /cpwr/license/license.dat>>license.log&

AIX In etc/rc.local, enter the following command on one line:

nohup /etc/lmgrd -c /cpwr/license/

license.dat>>license.log2>&1&
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LINUX In /etc/rc.d/rc2.d, create a file named s95cwlm.server and add the following 

command to the file:

nohup lmgrd -c /cpwr/license/license.dat>>license.log&

Manually Shutting Down the License Manager Server

On occasion, you may need to manually shut down the License Manager.

Type the following command:

/cpwr/license/lmutil lmdown

where /cpwr/license is the directory where the License Manager is located.

Installing a Single-User License on UNIX

Follow this procedure for installing a permanent single-user license on UNIX. The 

license.dat file must be installed on the workstation.

As an alternative to the steps below, you can use a Windows machine and the License 

Administration Utility’s Add function, then FTP the file to the UNIX machine.

1. Locate the existing license.dat file, or use a text editor to create a file named 

license.dat.

2. Paste or type your license string into the license.dat file (don’t include infor-

mation preceded with #). For example:

3. Save the license.dat file.

4. Set the LM_LICENSE_FILE environment variable in the global environment using 

the appropriate command for your particular shell.

C shell Use the following:

setenv LM_LICENSE_FILE /<full path to license file>/license.dat

SERVER ServerName 0020af9adb94 TCP:7166

DAEMON compuware ./compuwar

FEATURE xplus Compuware 4.600 12-jan-1999 10 6C74309CB84A9F07C5ED\

VENDOR_STRING=989898;0;PERM ck=12

Caution

The license string is case-sensitive. 
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Bourne shell Use the following:

LM_LICENSE_FILE=/<full path to license file>/license.dat 

Korn shell Use the following:

export LM_LICENSE_FILE=/<full path to license file>/license/dat
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Chapter 4.   Installing a License on Novell

Novell platforms use concurrent-user licensing exclusively. They do not support single-

user licenses. Concurrent-user licensing allows you to purchase a specific number of 

licenses without assigning these licenses to particular workstations. Instead, licenses are 

“checked out” by users on a first-come, first-served basis when they access the product. 

When all available licenses are issued, no additional users can run the product until 

another user exits and a license is “checked in.” This request-and-issue process is 

managed by the License Manager, specifically by the FLEXlm License Server service 

portion of the License Manager. The License Manager must be running on a computer or 

server that is always available to all client workstations needing access to the product. 

This chapter includes the following sections:

� Installing the License Manager — Instructions for installing the License Manager 

on the machine that acts as the FLEXlm server machine.

� Installing a License — Instructions for installing a concurrent-user license on the 

server machine.

� Configuring Each Client Machine — Instructions for configuring each client 

machine that will check out a license from the server machine.

� Configuring the License Manager for Automatic Startup — Instructions for 

configuring the License Manager to start up automatically whenever the server 

machine is rebooted.

� Configuring the License Manager for Automatic Startup — Instructions for 

shutting down the License Manager server manually.

� Diagnostics — Information about running diagnostics from a client machine.

Installing the License Manager 

Choose a stable Novell machine that is always available to be the License Manager 

server. To install the License Manager, follow these steps:
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1. Place all the files in the \cpwr\cwlm\novell subdirectory on the CD in SYS or 

VOL at the following path:

SYS (or vol name):\cpwr\license

2. Start Novell NetWare and enter the following command on one line on the Novell 

console:

Load SYS (or vol name):\cpwr\license\compuwar.nlm 

-c SYS (or vol name):\cpwr\license\license.dat

where compuwar.nlm is the license module from the CD, and license.dat is 

the permanent license on diskette.

3. To verify proper setup of the License Manager, enter the following command and 

search the listing for the compuwar.nlm module:

modules

Installing a License

You must have the License Manager installed before you proceed. If you have not yet 

installed the License Manager, see “Installing the License Manager” on page 4-1 for 

instructions. Follow this procedure for installing a permanent concurrent-user license on 

Novell. The license.dat file must be installed on the License Manager server.

1. Locate (on the License Manager server) the existing license.dat file, or use a 

text editor to create a file name license.dat and save it in the directory where the 

License Manager is located.

2. Paste or type your license string into the license file (don’t include information 

preceded with #). For example:

3. Save the license.dat file.

4. To start the License Manager, perform the procedure below for either the Novell 

server or remote console:

• From the Novell server console, type:

load SYS(or vol name):\cpwr\license\compuwar.nlm -c SYS:\cpwr\license\license.dat

SERVER NOV4_1SV 0020af9adb94 TCP:7166

DAEMON compuware compuwar

FEATURE QARun Compuware 4.600 12-jan-1999 10 6C74309CB84A9F07C5ED\

VENDOR_STRING=989898;0;PERM ck=12

Caution

The license string is case-sensitive. 
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• From the Novell remote console (Rconsole), type:

load SYS(or vol name):\cpwr\license\compuwar.nlm -c SYS:\cpwr\license\license.dat

5. To verify installation of the License Manager, type modules. Search the listing for 

the compuwar.nlm module.

Configuring Each Client Machine

Each client workstation must be configured to access the License Manager. This is a 

three-step process that includes (1) installing and configuring the IPX/SPX protocol on 

each client, (2) checking for DLLs, and (3) setting the license variable and communi-

cation variable using the SPX option or the TCP option. The following sections describe 

each of these steps for the various Windows platforms.

IPX/SPX 

Protocol on 

Windows NT 4.x 

1. Install and configure the IPX/SPX protocol on each client, using the appropriate 

procedure:

• Install the IPX/SPX protocol using Microsoft’s Novell NetWare client.

• Install Novell Client v4.11a, which you can download from www.novell.com.

2. Check that the following files are in the \windows\system or \system32 

directory. If Novell Client v4.11a  is installed, these files should have been automat-

ically copied to this directory. If not, copy the files from the 

\public\client\doswin directory on the Novell CD or the Novell server. 

Unpack the files with the nwunpack.exe utility, which is in the same directory.

• nwcalls.dll (\System)

• nwipxspx.dll (\System32)

• nwlocale.dll (\System)

• nwnet.dll (\System)

• tli_spx.dll (\System)

• tli_win.dll (\System)

3. Two variables must be set: (1) the license variable must be set to the license file, and 

(2) the communication variable must be set to the appropriate communication 

protocol. There are two options for setting variables and values:

• SPX option

Note

The FLEXlm environment is set using the License Administration Utility, which uses a 

registry setting. In special conditions, an environment variable can be used.
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• TCP option

SPX Option 

Windows NT 4.x

1. Click the taskbar’s Start button and choose Control Panel>System>Environment.

2. Set a system variable (not a user variable) to set the license variable to the license 

file:

a. In the Variable field, type LM_LICENSE_FILE.

b. In the Value field, type:

x:\Program Files\Compuware\license\license.dat

Where x:\Program Files\Compuware\license is the directory where 

your license file is located and license.dat is the name of your license file. 

This value is the local file, but it can be the mapped location on the server with 

the same information.

c. Click Set.

3. Set a system variable (not a user variable) to set the communication variable:

a. In the Variable field, type FLEXLM_COMM_TRANSPORT.

b. In the Value field, type SPX.

c. Click Set.

4. Click Apply.

5. Reboot the computer.

TCP Option 

Windows NT 4.x

1. Click the taskbar’s Start button and choose Control Panel>System>Environment.

2. Set a system variable (not a user variable) to set the license variable to the license 

file:

a. In the Variable field, type LM_LICENSE_FILE.

b. In the Value field, type one of the following:

x:\Program Files\Compuware\license\license.dat

or

7166@hostname

where x:\Program Files\Compuware\license is the directory where 

your license file is located, license.dat is the name of your license file, and 

hostname is the name of the host machine. This value is the local file, but it 

can be the mapped location on the server with the same information.

c. Click Set.

3. Set a system variable (not a user variable) to set the communication variable:
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a. In the Variable field, type FLEXLM_COMM_TRANSPORT.

b. In the Value field, type TCP.

c. Click Set.

4. Click Apply.

5. Reboot the computer.

IPX/SPX 

Protocol on 

Windows 2000

1. Install and configure the IPX/SPX protocol on each client, using the appropriate 

procedure:

• Install the IPX/SPX protocol using Microsoft’s Novell NetWare client.

• Install Novell Client v4.11a, which you can download from www.novell.com.

2. Check that the following files are in the \windows\system or \system32 

directory. If Novell Client v4.11a  is installed, these files should have been automat-

ically copied to this directory. If not, copy the files from the 

\public\client\doswin directory on the Novell CD or the Novell server. 

Unpack the files with the nwunpack.exe utility, which is in the same directory.

• nwcalls.dll (\System)

• nwipxspx.dll (\System32)

• nwlocale.dll (\System)

• nwnet.dll (\System)

• tli_spx.dll (\System)

• tli_win.dll (\System)

3. Two variables must be set: (1) the license variable must be set to the license file, and 

(2) the communication variable must be set to the appropriate communication 

protocol. There are two options for setting variables and values:

• SPX option

• TCP option

SPX Option 

Windows 2000

1. From the Start menu, select Settings>Control Panel

2. Click the System icon. On the System Properties dialog box, click the Advanced 

tab. Click Environment Variables. The user variables are in the upper section and 

the environment variables are in the lower section.

3. Click New in the System variables section. The New System Variable dialog box 

appears.

4. In the Variable Name field, type FLEXLM_COMM_TRANSPORT.

5. In the Variable Value field, type SPX. 
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6. Click OK. The environment variable you just set appears in the system variables 

list. Click OK.

7. When you are finished, reboot the computer for the changes to take effect.

TCP Option 

Windows 2000

1. From the Start menu, select Settings>Control Panel

2. Click the System icon. On the System Properties dialog box, click the Advanced 

tab. Click Environment Variables. The user variables are in the upper section and 

the environment variables are in the lower section.

3. Click New in the System variables section. The New System Variable dialog box 

appears.

4. In the Variable Name field, type FLEXLM_COMM_TRANSPORT.

5. In the Variable Value field, type one of the following:

x:\Program Files\Compuware\license\license.dat

or

7166@hostname

where x:\Program Files\Compuware\license is the directory where 

your license file is located, license.dat is the name of your license file, and 

hostname is the name of the host machine. This value is the local file, but it 

can be the mapped location on the server with the same information.

6. Click OK. The environment variable you just set appears in the system variables 

list. Click OK.

7. When you are finished, reboot the computer for the changes to take effect.

IPX/SPX 

Protocol on 

Windows 95x, 

98

1. Install and configure the IPX/SPX protocol on each client, using the appropriate 

procedure:

• Install the IPX/SPX protocol using Microsoft’s Novell NetWare client.

• Install Novell Client v2.5, which you can download from www.novell.com.

2. Check that the following files are in the \windows\system or \system32 

directory. If Novell Client v2.5  is installed, these files should have been automati-

cally copied to this directory. If not, copy the files from the 

\public\client\doswin directory on the Novell CD or the Novell server. 

Unpack the files with the nwunpack.exe utility, which is in the same directory.

• nwcalls.dll (\System)

• nwipxspx.dll (\System32)

• nwlocale.dll (\System)

• nwnet.dll (\System)
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• tli_spx.dll (\System)

• tli_win.dll (\System)

3. Two variables must be set: (1) the license variable must be set to the license file, and 

(2) the communication variable must be set to the appropriate communication 

protocol. There are two options for setting variables and values:

• SPX option

• TCP option

SPX Option 

Windows 95 or 

98

1. Use a text editor to set both the license variable and the communication variable. 

Open the autoexec.bat file and add the following two lines exactly as you see 

them.

set LM_LICENSE=c:\Program Files\Compuware\license\license.dat

Set FLEXLM_COMM_TRANSPORT=SPX

where c:\Program Files\Compuware\license is the directory where your 

license file is located and license.dat is the name of your license file. This value 

is the local file, but it can be the mapped location on the server with the same infor-

mation.

2. Reboot.

TCP Option 

Windows 95 or 

98

1. Use a text editor to set both the license variable and the communication variable. 

Open the autoexec.bat file and add one of the following two sets of lines exactly 

as you see them; the information is case-sensitive:

set LM_LICENSE_FILE=c:\Program Files\Compuware\license\license.dat

set FLEXLM_COMM_TRANSPORT=7166@hostname

or

set LM_LICENSE_FILE=7166@hostname

set FLEXLM_COMM_TRANSPORT=TCP

where c:\Program Files\Compuware\license is the directory where your 

license file is located, license.dat is the name of your license file, and host-

name is the name of the host machine. This value is the local file, but can be the 

mapped location on the server with the same information.

2. Reboot.

Configuring the License Manager for Automatic Startup

Because all license validation is done by the License Manager, it must be started and kept 

running in order to use Compuware products. The License Manager must be started on 
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the machine where it was installed. To automatically start the License Manager when the 

server is started, add the following command to the server’s autoexec.ncf file:

load c:\cpwr\license\compuwar.nlm -c c:\cpwr\license\license.dat

where c:\cpwr\license is the Novell server directory where compuwar.nlm is located and 

license.dat is the name of your license file.

Manually Shutting Down the License Manager Server

On occasion, you may need to manually shut down the License Manager. To do so, type 

the following command from the Novell console:

Unload compuwar.nlm

Diagnostics

Both the License Administration Utility and the lmutil commands are available, but 

diagnostics can only be run from the client machine.
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